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1 Introduction

Overview
The Specman™ Elite™ verification system provides benefits that result in:

• Reductions in the time and resources required for verification

• Improvements in product quality

The Specman Elite system automates verification processes, provides functional coverage
analysis, and raises the level of abstraction for functional coverage analysis from the RTL
to the architectural/specification level. This means that you can:

• Easily capture your design specifications to set up an accurate and appropriate
verification environment

• Quickly and effectively create as many tests as you need

• Create self-checking modules that include protocols checking

• Accurately identify when your verification cycle is complete

The Specman Elite system provides three main enabling technologies that enhance your
productivity:

• Constraint-driven test generation—You control automatic test generation by
capturing constraints from the interface specifications and the functional test plan.
Capturing the constraints is easy and straightforward.
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• Data and temporal checking—You can create self-checking modules that ensure data
correctness and temporal conformance. For data checking, you can use a reference
model or a rule-based approach.

• Functional coverage analysis—You avoid creating redundant tests that waste
simulation cycles, because you can measure the progress of your verification effort
against a functional test plan.

Figure 1-1 shows the main component technologies of the Specman Elite system and its
interface with an HDL simulator.

Figure 1-1 The Specman Elite System Automates Verification

Specman Elite verification system

Constraint-driven
test generation

Functional coverage
analysis

HDL simulator

HDL models Legacy code
(HDL)

Data and temporal
checking

Legacy code
(C language)

 Interface specification
(e language)

Functional test plan
(e language)
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Tutorial Goals
This tutorial is for use with Specman Elite version 4.0 and higher.

The goal of this tutorial is to give you first-hand experience in how the Specman Elite
system effectively addresses functional verification challenges.

As you work through the tutorial, you follow the process described in Figure 1-2. The
tutorial uses the Specman Elite system to create a verification environment for a simple
CPU design.

Figure 1-2 Tutorial Verification Task Flow

Define DUT interfaces

Drive and sample the
DUT

Generate constraint-
driven tests

Define and analyze test
coverage

Create corner-case
tests

Create temporal and
data checks

Generate a simple test

Analyze and bypass
bugs

Design the verification
environment
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Setting up the Tutorial Environment
Before starting the design verification task flow shown in Figure 1-2 on page 1-3, you must
set up the tutorial environment.

To set up the tutorial environment:

1. Download the Specman Elite software and tutorial files (see “Setting up the Tutorial
Environment” on page A-1).

2. Install the Specman Elite software.

3. Install the tutorial files.

See Appendix A, “Setting up the Tutorial Environment”, for detailed instructions.

Note Even if Specman Elite software is currently installed in your environment,
you still have to download and install the tutorial files.

Document Conventions
This tutorial uses the document conventions described in Table 1-1.

Table 1-1 Document Conventions

Visual Cue Meaning

courier Specman Elite or HDL code. For example,

keep opcode in [ADD, ADDI];

courier bold Text that you need to type exactly as it appears to complete a
procedure or modify a file.

bold In text, bold indicates Specman Elite keywords. For example, in the
phrase “theverilog trace statement,”verilog andtrace are
keywords.

% In examples that show commands being entered, the%  symbol
indicates the UNIX prompt.

SN> In examples that show commands being entered in the Specman
Elite system, SN> indicates the Specman Elite prompt.
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2 Understanding the
Environment

Goals for this Chapter
This tutorial uses a simple CPU design to illustrate the benefits of using the Specman Elite
system for functional verification. This chapter introduces the overall verification
environment for the tutorial CPU design, based on the design specifications, interface
specifications, and the functional test plan.

What You Will Learn
Part of the productivity gain provided by the Specman Elite system derives from the ease
with which you can capture the specifications and functional test plan in executable form.
In this chapter, you become familiar with the design specifications, the interface
specifications, and the functional test plan for the CPU design. You also become familiar
with the overall CPU verification environment.

The following sections provide brief descriptions of the:

• Design specifications

• Interface specifications

• Functional test plan

• Overall verification environment
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For more detailed information on the CPU instructions, the CPU interface, and the CPU’s
internal registers, see Appendix B, “Design Specifications for the CPU”.

The Design Specifications
The device under test (DUT) is an 8-bit CPU with a reduced instruction set (Figure 2-1).

Figure 2-1 CPU Block-Level Diagram

The state machine diagram for the CPU is shown in Figure 2-2. The second fetch cycle is
only for immediate instructions and for instructions that control execution flow.

Figure 2-2 CPU State Machine Diagram

There is a 1-bit signal associated with each state,exec, fetch2, fetch1, start. If no reset
occurs, thefetch1signal must be asserted exactly one cycle after entering the execute state.
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The Interface Specifications
All instructions have a 4-bit opcode and two operands. The first operand is one of four
4-bit registers internal to the CPU. The second operand is determined by the type of
instruction:

• Register instructions—The second operand is another one of the four internal
registers.

Figure 2-3 Register Instruction

• Immediate instructions—The second operand is an 8-bit value. When the opcode is
of type JMP, JMPC, or CALL, this operand must be a 4-bit memory location.

Figure 2-4 Immediate Instruction

The Functional Test Plan
We need to create a series of tests that will result in adequate test coverage for most aspects
of the design, including some rare corner cases. There will be three tests in this series.

Test 1

Test Objective

A simple go-no-go test to confirm that the verification environment is working properly.

byte 1

bit 7 6 5 4 3 2 1 0

opcode op1 op2

byte 1 2

bit 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

opcode op1 don’t
care

op2
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Test Specifications

• Generate five instructions.

• Use either the ADD or ADDI opcode.

• Set op1 to REG0.

• Set op2 either to REG1 for a register instruction or to value 0x5 for an immediate
instruction.

Test 2

Test Objective

Multiple random variations on a test to gain high percentage coverage on commonly
executed instructions.

Test Specifications

• Use constraints to direct random testing towards the more common arithmetic and logic
operations rather than the control flow operations.

• Run the test 15 times, each time with a different random seed.

Test 3

Test Objective

Generation of a corner case test scenario that exercises JMPC opcode when carry bit is
asserted. Note that it is difficult to efficiently cover this scenario by purely random or
purely directed tests.

Test Specifications

• Generate many arithmetic opcodes to increase the chances of carry bit assertion.

• Monitor the DUT and use on-the-fly generation to generate many JMPC opcodes when
the carry signal is high.
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Overview of the Verification Environment
The overall test strategy, shown in Figure 2-5, is to:

• Constrain the Specman Elite test generator to create valid CPU instructions.

• Compare the program counters in the CPU to those in a reference model.

• Define temporal rules to check the DUT behavior.

• Define coverage points for state machine transitions and instructions.

Figure 2-5 Design Verification Environment Block-Level Diagram
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Reference Model

Device Under Test

Coverage Reports

Test Generator

Instructions Checker

Coverage

Functional
Coverage

Points

Pass

Fail

Constraints



Understanding the Environment Overview of the Verification Environment

2-6 © Verisity Design, Inc. Specman Elite Tutorial

Because the focus of this tutorial is the Specman Elite system, we do not include an HDL
simulator. Rather than instantiating an HDL DUT, we model the DUT ineand simulate it
in Specman Elite. The process you use to drive and sample the DUT ine is exactly the
same as a DUT in HDL.

Now you are ready to create the first piece of the verification environment, the CPU
instruction stream.
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3 Creating the CPU
Instruction Structure

Goals for this Chapter
The first task in the verification process is to set up the verification environment. In this
chapter you start creating the environment by defining the inputs to the design, the CPU
instructions.

What You Will Learn
In this chapter you learn how to create a data structure and define specification constraints
that enable the Specman Elite system to generate a legal instruction stream. By the end of
this chapter, you will have created the core structure for the CPU instructions. This core
structure will be used and extended in subsequent chapters to create the tests.

As you work through this chapter, you gain experience with one of the Specman Elite
system’s enabling features—easy specification capture. Using a few constructs from the
e language, you define the legal CPU instructions exactly as they are described in the
interface specifications.
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This chapter introduces theeconstructs shown in Table 3-1.

To create the CPU instruction structure, you must:

• Capture the interface specifications

• Create a list of instructions

The following sections explain how to perform these tasks.

Capturing the Specifications
In this task, you create the data structure for the instruction stream and constrain the test
generator to generate only legal CPU instructions. Individual tests that you create later can
constrain the generator even further to test some particular functionality of the CPU.

For a complete description of the legal CPU instructions, refer to Appendix B, “Design
Specifications for the CPU”.

Table 3-1 New Constructs Used in this Chapter

Construct How the Construct is Used

<'…'> Marks the beginning and end ofecode.

struct Creates a data structure to hold the CPU instructions.

extend Adds the data structure for the CPU instructions to the Specman Elite
system of data structures.

list of Creates an array or list without having to keep track of pointers or
allocate memory.

type Defines an enumerated data type for the CPU instructions.

bits Defines the width of an enumerated type.

keep Specifies rules or constraints for the instruction fields.

when Implements conditional constraints on the possible values of the
instruction fields.
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Procedure

To capture the design specifications ine:

1. Make a new working directory and copy thesrc/CPU_instr.e file to the working
directory.

2. Open theCPU_instr.e file in an editor.

The first part of the file has a summary of the design specifications for the CPU
instructions.

CPU_instr.e: Basic structure of CPU instructions
This module defines the basic structure of CPU instructions,

according to the design and interface specifications.

* All instructions are defined as:
Opcode   Operand1   Operand2

* There are 2 types of instructions:

Register Instruction:
bit | 7 6 5 4 | 3 2 | 1 0 |

| opcode | op1 | op2 |
(reg)

Immediate Instruction:
byte | 1 | 2 |

bit | 7 6 5 4 | 3 2 | 1 0 | 7 6 5 4 3 2 1 0 |
| opcode | op1 | don’t | op2 |

| care |

* Register instructions are:
ADD, SUB, AND, XOR, RET, NOP

* Immediate instructions are:
ADDI, SUBI, ANDI, XORI, JMP, JMPC, CALL

* Registers are REG0, REG1, REG2, REG3
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3. Find the portion of the file that starts with the <' ecode delineator and review the
constructs:

4. Define two fields in theinstr structure, one to hold the opcode and one to hold the first
operand.

Use the enumerated types,cpu_opcodeandreg, to define the types of these fields. To
indicate that the Specman Elite system must drive the values generated for these fields
into the DUT, place a% character in front of the field name. You will see how
this% character facilitates packing automation in Chapter 5, “Driving and Sampling
the DUT”.

<'
type cpu_opcode: [ // Opcodes

ADD, ADDI, SUB, SUBI,
AND, ANDI, XOR, XORI,
JMP, JMPC, CALL, RET,
NOP

] (bits: 4);

type reg: [ // Register names
REG0, REG1, REG2, REG3

] (bits:2);

struct instr {

// defines 2nd op of reg instruction

// defines 2nd op of imm instruction

// defines legal opcodes for reg instr

// defines legal opcodes for imm instr

// ensures 4-bit addressing scheme

};

extend sys {
// creates the stream of instructions

};
'>

defines the legal
opcodes as an

enumerated type

defines the
internal registers

when complete,
this structure

defines a valid
CPU instruction

// indicates that
rest of line is a

comment

when complete,
this construct

adds the CPU
instruction set to

the Specman Elite
system
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The structure definition should now look like this:

5. Define a field for the second operand.

The second operand is either a 2-bit register or an 8-bit memory location, depending
on the kind of instruction, so you need to define a single field (kind) that specifies the
two kinds of instructions. Because the generated values forkindare not driven into the
design, do not put a%  in front of the field name.

struct instr {
%opcode :cpu_opcode;
%op1 :reg;

// defines 2nd op of reg instruction
.
.
.
};

add these two
lines into the file

struct instr {
%opcode :cpu_opcode;
%op1 :reg;
kind :[imm, reg];

// defines 2nd op of reg instruction
.
.
.
};

add this line to
define the field

‘kind’ and define
an enumerated

type at the
same time
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6. Define the conditions under which the second operand is a register and those under
which it is a byte of data.

You can use thewhen construct to do this.

7. Constrain the opcodes for immediate instructions and register instructions to the
proper values.

struct instr {
%opcode :cpu_opcode;
%op1 :reg;
kind :[imm, reg];

// defines 2nd op of reg instruction
when reg instr {

%op2 :reg;
};

// defines 2nd op of imm instruction
when imm instr {

%op2 :byte;
};

.

.

.
};
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Whenever the opcode is one of the register opcodes, then thekind field must bereg.
Whenever the opcode is one of the immediate opcodes, then thekind field must be
imm. You can use thekeepconstruct with the implication operator=> to easily create
these complex constraints.

8. Constrain the second operand to a valid memory location (less than 16) when the
instruction is immediate.

You can use thewhen construct together withkeep and=> to create this constraint.

9. Save theCPU_instr.e file.

Now you have finished defining a legal CPU instruction.

struct instr {
.
.
.

// defines legal opcodes for reg instr
keep opcode in [ADD, SUB, AND, XOR, RET, NOP]

=> kind == reg;

// defines legal opcodes for imm instr
keep opcode in [ADDI, SUBI, ANDI, XORI, JMP, JMPC, CALL]

=> kind == imm;

// ensures 4-bit addressing scheme

};

struct instr {
.
.
.

// ensures 4-bit addressing scheme
when imm instr {

keep opcode in [JMP, JMPC, CALL] => op2 < 16;
};

};
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Creating the List of Instructions
In this task, you create a CPU instruction structure by extending the Specman Elite system
(sys) to include a list of CPU instructions.sys is a built-in Specman Elite structure that
defines a generic verification environment.

Procedure

To create the list of instructions:

1. Within the sameCPU_instr.efile, find the lines of code that extend the Specman Elite
system:

2. Create a field for the instruction data of typeinstr.

When defining a field that is an array or a list, you must precede the field type with the
keywordlist of.

The exclamation point preceding the field nameinstrstells the Specman Elite system
to create an empty data structure to hold the instructions. Then, each test tells the
system when to generate values for the list, either before simulation (pre-run
generation) or during simulation (on-the-fly generation). In this tutorial you use both
types of generation.

3. Save theCPU_instr.e file.

Now you have created the core definition of the CPU instructions. You are ready to
extend this definition to create the first test.

extend sys {
// creates a stream of instructions

};

extend sys {
// creates a stream of instructions
!instrs: list of instr;

};
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4 Generating the First Test

Goals for this Chapter
In this chapter, you will generate the first test described in “The Functional Test Plan” on
page 2-3. This first test is a simple test to confirm that the verification environment is set up
correctly and that you can generate valid instructions for the CPU model.

What You Will Learn
In this chapter, you learn how to create different types of tests easily by specifying test
constraints in the Specman Elite system. Test constraints direct the Specman Elite
generator to a specific test described in the functional test plan. This chapter illustrates how
the Specman Elite system can quickly generate an instruction stream. In the next chapter,
you will learn how to drive this instruction stream to verify the DUT.

As you work through this chapter to create the first test, you gain experience with the
following enabling features of the Specman Elite system:

• Extensibility—This enables adding definitions, constraints, and methods to a struct in
order to change or extend its original behavior without altering the original definition.

• Constraint solver—This is the core technology that intelligently resolves all
specification constraints and test constraints and then generates the desired test.
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This chapter shows new uses of theeconstructs introduced in Chapter 3, “Creating the
CPU Instruction Structure”. It also introduces the Specview menu commands shown in
Table 4-1.

Tip In most cases, the Specview menu commands presented in this tutorial can be
issued by clicking a button. For example, clicking the Load button in the
Specview main window is the same as choosing Load from the File menu.
Similarly, you can click the Modules button instead of choosing Modules from
the File menu or click Test instead of choosing Test from the Test menu.

The steps required to generate the first test for the CPU model are:

1. Defining the test constraints.

2. Loading the verification environment into the Specman Elite system.

3. Generating the test.

The following sections explain how to perform these steps.

Table 4-1 New Constructs and Specview Menu Commands Used in this
Chapter

Construct How the Construct is Used

extend Adds constraints to thesys andinstr structs defined in Chapter 3,
“Creating the CPU Instruction Structure”.

keep Limits the possible values of the instruction fields and the number
of instructions generated for this test.

when Defines conditional constraints.

Command How the Command is Used

File>>Load Loads uncompiledemodules into the Specman Elite system.

File>>Modules Lists theemodules you have loaded into the Specman Elite
system.

Test>>Test Generates a test based on the constraints you specify.

Tools>>Data
Browser

Opens the Data Browser GUI, in which you view the hierarchy of
generated objects and their values.
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Defining the Test Constraints
The Functional Test Plan for the CPU design (see “The Functional Test Plan” on page 2-3)
describes the objectives and specifications for this first test.

Test Objective

The objective is to confirm that the verification environment is working properly.

Test Specifications

To meet the test objective, the test should:

• Generate five instructions.

• Use either the ADD or ADDI opcode.

• Set op1 to REG0.

• Set op2 either to REG1 for a register instruction or to value 0x5 for an immediate
instruction.

Procedure

To capture the test constraints ine:

1. Copy thesrc/CPU_tst1.e to the working directory and open theCPU_tst1.e file in an
editor.
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2. Find the portion of the file that looks like this:

3. Add lines below the comments as follows to constrain the opcode, operands, and
number of instructions:

4. Save theCPU_tst1.efile.

<'
import CPU_top;

extend instr {
// test constraints

};

extend sys {
// generate 5 instructions

};
.
.
.

constrains the
opcode and

operands

constrains the
number of

instructions

<'
extend instr {

//test constraints
keep opcode in [ADD, ADDI];
keep op1 == REG0;
when reg instr { keep op2 == REG1; };
when imm instr { keep op2 == 0x5; };

};

extend sys {
//generate 5 instructions
keep instrs.size() == 5;

};
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Loading the Verification Environment
To run the first test, you need the following files:

• CPU_tst1.e—imports (includes)CPU_top.e and contains the test constraints for the
first test.

• CPU_top.e—importsCPU_instr.e andCPU_misc.e.

• CPU_instr.e—contains the definitions and specification constraints for CPU
instructions.

• CPU_misc.e—configures settings for print and coverage display.

These files are called modules in the Specman Elite system. Before the system can
generate the test, you must load all the modules.

Procedure

To load all modules:

1. Copy thesrc/CPU_top.e file to the working directory.

2. Copy thesrc/CPU_misc.e file to the working directory.

The working directory should now contain four files:CPU_instr.e, CPU_misc.e,
CPU_top.e, andCPU_tst1.e

3. From the working directory, type the following command at the UNIX prompt to
invoke Specman Elite’s graphical user interface, Specview™:

% specview &

Tip If the Specview main window (Figure 4-1) does not appear, make sure that you
have defined the Specman Elite environment variables correctly. You can source
the install_dir/release_number/env.csh file to set these variables.
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Figure 4-1 Specview Main Window

4. Choose Load from the File menu or click the Load button.

The Select A File dialog box appears.

5. In the Select A File dialog box, double-clickCPU_tst1.e in the list of files.

Specview automatically loads all four files contained in your working directory. In the
Specview main window, you should see a message that looks as follows:

Loading CPU_instr.e (imported by CPU_top.e) ...
Loading CPU_misc.e (imported by CPU_top.e) ...
Loading CPU_top.e (imported by CPU_tst1.e) ...
Loading /tutorial/CPU_tst1.e ...

Tip If the CPU_tst1.efile name does not appear in the dialog box, you probably did
not invoke Specview from the working directory. Use the list of directories in the
dialog box to navigate to the working directory.

Tip If theCPU_tst1.efile does not load completely because of a syntax error, use the
UNIX diff utility to compare your version ofCPU_tst1.e to
tutorial/gold/CPU_tst1.e. Fix the error and click the Reload button.
Alternatively, you can click the blue hypertext link in the Specview main
window, and the error location will be displayed in the Debugger window.

To see a list of loaded modules, choose Modules from the File menu or click the Modules
button.

There should be four modules loaded:

CPU_instr
CPU_misc
CPU_top
CPU_tst1



Generating the Test Generating the First Test

Specman Elite Tutorial © Verisity Design, Inc. 4-7

Generating the Test
To generate the test:

1. In the Specview main window, click the Test button.

You should see the following output in the Specview main window.

2. In the Tools menu, choose Data Browser, and then choose Show Data Sys.
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The Data Browser GUI appears.

3. Click the blueinstrs = 5 items link in the left panel.
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The list of five generated instructions appears in the top right panel.

4. Double-click the bluereg instr-@1 link in the top right panel.
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The generated values for the fields of the first instruction object appear in the right
panel.

Tip If the results you see are significantly different from the results shown here, use
the UNIX diff utility to compare your version of thee files to the files in
tutorial/gold/.

5. Click each of the otherinstrs[n] lines in the left panel and review their contents in the
right panel to confirm that the instructions follow both the general constraints for CPU
instructions and the constraints for this particular test.

Based on the definition, specification constraints, and test constraints that you have
provided, the Specman Elite generator quickly generated the desired instruction stream.
Now you are ready to drive this instruction stream into the DUT and run simulation.
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5 Driving and Sampling
the DUT

Goals for this Chapter
In this chapter, you will drive the DUT with the instruction stream you generated in the last
chapter.

In a typical verification environment, where the DUT is modeled in an HDL, you need to
link the Specman Elite system with an HDL simulator before running simulation. To
streamline this tutorial, we have modeled the DUT ine.

What You Will Learn
In this chapter, you learn how to describe ine the protocols used to drive test data into the
DUT. Although this tutorial does not use an HDL simulator, the process of driving and
sampling a DUT written in HDL is the same as the process for a DUT written ine.

As you work through this chapter, you gain experience with these features of the Specman
Elite verification system:

• DUT signal access—You can easily access signals and variables in the DUT, either for
driving and sampling test data or for synchronizing TCMs.

• Simulator interface automation—You can drive and sample a DUT without having
to write PLI (Verilog simulators) or FLI/CLI (VHDL simulators) code. The Specman
Elite system automatically creates the necessary PLI/FLI calls for you.
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• Time consuming methods (TCMs)—You can write procedures ine that are
synchronized to other TCMs or to an HDL clock. You can use these procedures to drive
and sample test data.

This chapter introduces theeconstructs shown in Table 5-1.

The steps for driving and sampling the DUT are:

1. Defining the protocols.

2. Running the simulation.

The following sections describe how to perform these steps.

Defining the Protocols
There are two protocols to define for the CPU:

• Reset protocol—drives therst signal in the DUT.

• Drive instructions protocol—drives instructions into the DUT according to the correct
protocol indicated byfetch1 andfetch2 signals.

Table 5-1 New Constructs Used in this Chapter

Construct How the Construct is Used

emit Triggers a named event from within a TCM.

@ Synchronizes the TCMs with an event.

event Creates a temporal object, in this case a clock, that is used to
synchronize the TCMs.

'hdl_signal_name' Accesses a signal in the DUT.

method() is… Creates a procedure (method) that is a member of a struct and
manipulates the fields of that struct. Methods can execute in a
single point of time, or they can be time consuming methods
(TCMs).

pack () Converts data from higher levelestructs and fields into the bit or
byte representation expected by the DUT.

wait Suspends action in a TCM until the expression is true.
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Drive instructions protocol has one TCM forpre-run generation, where the complete list
of instructions is generated and then simulation starts. There is another TCM foron-the-fly
generation, where signals in the DUT are sampled before the instruction is generated. The
test in this chapter uses the simple methodology of pre-run generation, while subsequent
tests in this tutorial use the more powerful on-the-fly generation.

All the TCMs required to drive the CPU are described briefly in Table 5-2. A complete
description of one of the TCMs follows the table. You can also view theCPU_drive.e file
in thesrc directory, if you want to see the complete description of the other TCMs ine.

Figure 5-1 shows theecode for thedrive_one_instr () TCM. The CPU architecture
requires that tests drive and sample the DUT on the falling edge of the clock. Therefore, all
TCMs are synchronized tocpuclk, which is defined as follows:

extend sys  {
event  cpuclk is  ( fall (’top.clk’) @sys.any);

};

Table 5-2 TCMs Required to Drive the CPU

Name Function

drive_cpu() Callsreset_cpu (). Then, depending on whether the list of
CPU instructions is empty or not, calls
gen_and_drive_instrs () or drive_pregen_instrs ().

reset_cpu() Drives therst signal in the DUT to low for one cycle, to high
for five cycles, and then to low.

gen_and_drive_instrs() Generates the next instruction and callsdrive_one_instr ().

drive_pregen_instrs() Callsdrive_one_instr () for each generated instruction.

drive_one_instr() Sends the instruction to the DUT. If the instruction is an
immediate instruction, also waits for thefetch2signal to rise
and sends the second byte of data. Then waits for theexec
signal to rise.
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Figure 5-1 The drive_one_instr () TCM

The assignment statements in Figure 5-1 show how to drive and sample signals in an HDL
model. Each pair of single quotation marks identifies an object as an HDL signal.

Thestart_drv_DUTevent emitted bydrive_one_instris not used by any of the TCMs that
drive the CPU. You will use it in a later chapter to trigger functional coverage analysis.

The last line shown in Figure 5-1 executes the reference model and is commented out at
the moment. You will use it in a later chapter to trigger data checking.

Thepack() function is a Specman Elite built-in function that facilitates the conversion
from higher level data structure to the bit stream required by the DUT. In Chapter 3,
“Creating the CPU Instruction Structure”, you used the% character to identify the fields
that should be driven into the DUT. Thepack() function intelligently and automatically
performs the conversion, as shown in Figure 5-2.

drive_one_instr(instr: instr) @sys.cpuclk is {
var fill0 : uint(bits : 2) = 0b00;

wait until rise('top.fetch1');

emit instr.start_drv_DUT;

if instr.kind == reg then {
'top.data' = pack(packing.high, instr);

} else {
// immediate instruction

'top.data' = pack(packing.high, instr.opcode,
instr.op1, fill0);

wait until rise('top.fetch2');
'top.data' = pack(packing.high, instr.imm'op2);

};

wait until rise('top.exec');

// execute instr in refmodel
//sys.cpu_refmodel.execute(instr, sys.cpu_dut);

};
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Figure 5-2 A Register Instruction as Received by the DUT

Running the Simulation
This procedure, which involves loading the appropriate files and clicking the Test button,
is very similar to the procedure you used in the last chapter to generate the first test.

The difference is that this time you are including the DUT (contained inCPU_dut.e) and
TCMs that drive it (contained inCPU_drive.e).

Procedure

To run the simulation:

1. Copy thesrc/CPU_dut.e to the working directory.

2. Copy thesrc/CPU_drive.e to the working directory.

3. Open the working directory’s copy of theCPU_top.e file in an editor.

The instruction struct with three fields:

opcode == ADD

op1 == REG0

0

0 0 0

00

000 0 0 10

The instruction packed into a bit stream, using the packing.high ordering

opcode op1

list of bit [7] list of bit [0]

0

op2

op2 == REG1 10
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4. Find the lines in the file that look like this:

5. Remove the comment characters in front of theimport line so the lines look like this:

6. Save theCPU_top.e file.

7. Click the Reload button to reload the files for test 1.

Tip If you have exited Specview, you must reinvoke it and loadCPU_tst1.e again.
To do so, enter thespecview command at the UNIX prompt, click on the Load
button, and chooseCPU_tst1.e.

Tip If you see a message such as

*** Error: No match for 'CPU_dut.e'

you need to check whether the working directory contains the following files:

Add the missing file and then click the Reload button.

8. Click the Modules button to confirm that six modules are loaded:

Tip If some of the modules are missing, first check whether you are loading the
CPU_top.efile that you just modified. The modifiedCPU_top.efile must be in
the working directory. Once the modifiedCPU_top.e file is in the working

CPU_instr.e CPU_drive.e

CPU_misc.e CPU_top.e

CPU_dut.e CPU_tst1.e

CPU_instr CPU_drive

CPU_misc CPU_top

CPU_dut CPU_tst1

// Add dut and drive:
//import CPU_dut, CPU_drive;

// Add dut and drive:
import CPU_dut, CPU_drive;
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directory, click the Restore button. This action should remove all the currently
loaded modules from the session. Then click Load and chooseCPU_tst1.ein the
Select A File dialog box.

9. Click Test to run the simulation.

You should see the following messages (or something similar) in the Specview main
window.

Doing setup…
Generating the test using seed 0x1…
Starting the test…
Running the test…
DUT executing instr 0 : ADD REG0x0, REG0x1
DUT executing instr 1 : ADD REG0x0, REG0x1
DUT executing instr 2 : ADDI REG0x0, @0x05
DUT executing instr 3 : ADDI REG0x0, @0x05
DUT executing instr 4 : ADD REG0x0, REG0x1
Last specman tick - stop_run() was called
Normal stop - stop_run() is completed
Checking the test…
Checking is complete - 0 DUT errors, 0 DUT warnings.
Wrote 1 cover_struct to CPU_tst1_1.ecov

You can see from the output that five instructions were executed and no errors were found.
It looks like the verification environment is working properly, so you are ready to generate
a large number of tests.
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6 Generating
Constraint-Driven Tests

Goals for this Chapter
In this chapter, you will run the second test described in “The Functional Test Plan” on
page 2-3. To meet the objective of the second test, you must run the same test multiple
times using constraints to direct random testing towards the more common operations of
the CPU. Through this automatic test generation, we hope to gain high test coverage for
the CPU instruction inputs.

What You Will Learn
In this chapter, you learn how to quickly generate different sets of tests by simply changing
the seed used for constraint-driven test generation. You also learn how to use weights to
control the distribution of the generated values to focus the testing on the common CPU
instructions.

As you work through this chapter, you gain experience with two of the Specman Elite
verification system’s enabling features:

• Directed-random test generation—This feature lets you apply constraints to focus
random test generation on areas of the design that need to be exercised the most.

• Random seed generation—Changing the seed used for random generation enables
the Specman Elite system to quickly generate a whole new set of tests.
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This chapter introduces theeconstructs and Specview menu commands shown in
Table 6-1.

The steps for generating random tests are:

1. Defining weights for random tests.

2. Generating and running tests with a user-specified seed.

3. Generating and running tests with a random seed.

The following sections describe these tasks in detail.

Defining Weights for Random Tests
Because of the way that CPUs are typically used, arithmetic and logical operations
comprise a high percentage of the CPU instructions. You can use theselectconstruct with
keep soft to require the Specman Elite system to generate a higher percentage of
instructions for arithmetic and logical operations than for control flow.

Table 6-1 New Constructs and Specview Menu Commands Used in this
Chapter

Construct How the Construct is Used

keep soft Specifies a soft constraint that is kept only if it does not conflict
with other hardkeep constraints.

select Used withkeep soft to control the distribution of the generated
values.

Command How the Command is Used

Tools>>Config Used to access the Generation tab of the Specman Elite
Configuration Options window for creating a user-defined seed
for random test generation.

File>>Save Saves the current test environment, including the random seed, to
a .esv file. You can load this file with the File>>Restore
command.

Test>>Test with
Random Seed

Generates a set of tests with a new random seed.
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Procedure

To see how weighted constraints are created ine:

1. Copy thesrc/CPU_tst2.e file to the working directory.

2. Open theCPU_tst2.e file in an editor.

3. Find the portion of the file that looks as follows and review thekeep soft constraint.

Generating Tests With a User-Specified Seed
You can specify the random seed that the Specman Elite system uses to generate tests.

Procedure

This procedure shows how to create a random seed:

1. In the Specview main window, click Restore to remove all theemodules from the
current session.

2. Click Load. Then double-click theCPU_tst2.e file.

The Specman Elite system loads theCPU_tst2.efile along with its imported modules.

3. Click Modules and confirm that the following modules are loaded:

CPU_instr CPU_drive

CPU_misc CPU_top

CPU_dut CPU_tst2

<'

extend instr {
keep soft opcode == select {

30 : [ADD, ADDI, SUB, SUBI];
30 : [AND, ANDI, XOR, XORI];
10 : [JMP, JMPC, CALL, RET, NOP];

};
};

'>

puts equal weight
on arithmetic and
logical operations

and less weight
on control flow

operations
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4. Click the Config button or choose Config from the Tools menu.

The Specman Elite Configuration Options window opens.

5. Choose the Generation tab and then enter a number of your choice in the text box under
Seed.

6. Click OK to save the settings and close the window.

7. Click the Test button on the Specview main window.

The Specman Elite system runs the test with the your seed and reports the results.

8. In the Tools menu, choose Data Browser and then choose Show Data Sys.

The Data Browser GUI appears.

9. Click the blueinstrs = 59 items link in the left panel.

Instructions are listed in the top right panel. By default, only the first 25 instructions
are listed. You can click the Config button in the Data Browser, and then change the
number of list items to 59 to list all of the instructions.
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You should see an approximately equal distribution of arithmetic and logical
operations, and about one-third as many control flow operations as there are either
arithmetic or logical operations.
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Generating Tests With a Random Seed
You can require the Specman Elite system to generate a random seed.

Procedure

To run a test using a Specman Elite-generated random seed:

1. In the Specview main window, click the Reload button.

2. Choose Test>>Test With Random Seed.

The Specman Elite system runs the test with the random seed shown in the Specview
main window and reports the results.

3. Review the results in the Data Browser, as in the previous procedure.

You should again see an approximately equal distribution of arithmetic and logical
operations, and about one-third as many control flow operations as there are either
arithmetic or logical operations. The results should be different from the previous run.

4. Optionally you can repeat steps 1-3 several times to confirm that you see different
results each time.

Tip If you see similar results in subsequent runs, it is likely that you forgot to reload
the design before running the test. If you do not reload the design, the test is run
with the current seed.

You can see that using different random seeds lets you easily generate many tests. Quickly
analyzing the results of all these tests would be difficult without Specman Elite’s coverage
analysis technology. The next two chapters show how to use coverage analysis to
accurately measure the progress of your verification effort.
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7 Defining Coverage

Goals for this Chapter
You can avoid redundant testing by measuring the progress of the verification effort with
coverage statistics for your tests. This chapter explains how to define the test coverage
statistics you want to collect.

What You Will Learn
In this chapter, you learn how to define which coverage information you want to collect for
the DUT internal states, for the instruction stream, and for an intersection of DUT states
and the instruction stream.

As you work through this chapter, you gain experience with another one of the Specman
Elite verification system’s enabling features—theFunctional Coverage Analyzer. The
Specman Elite coverage analysis feature lets you define exactly what functionality of the
device you want to monitor and report. With coverage analysis, you can see whether
generated tests meet the goals set in the functional test plan and whether these tests
continue to be sufficient as the design develops, the design specifications change, and bug
fixes are implemented.
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This chapter introduces theeconstructs shown in Table 7-1.

The three types of coverage data that you might want to collect are:

• Coverage data for the finite state machine (FSM).

• Coverage data for the generated instructions.

• Coverage data for the corner case.

The following sections describe how to define coverage for these three types of data.

Defining Coverage for the FSM
You can use the constructs shown in Table 7-1 to define coverage for the FSM:

• State machine register

• State machine transition

Procedure

To define coverage for the FSM:

1. Copy thesrc/CPU_cover.e file to the working directory and openCPU_cover.e in an
editor.

Table 7-1 New Constructs Used in this Chapter

Construct How the Construct is Used

event Defines a condition that triggers sampling of coverage data.

cover Defines a group of data collection items.

item Identifies an object to be sampled.

transition Identifies an object whose current and previous values are to
be collected when the sampling event occurs.
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2. Find the portion of the file that looks like the excerpt below and review the declaration
that defines the sampling event for the FSM:

3. Add the coverage group and coverage items for state machine coverage.

The coverage group name (cpu_fsm) must be the same as the event name defined in
Step 2 above. Theitem statement declares the name of the coverage item (fsm), its
data type (FSM_type), and the object in the DUT to be sampled. Thetransition
statement says that the current and previous values offsm must be collected. This
means that whenever thesys.cpuclksignal changes, the Specman Elite system collects
the current and previous values oftop.cpu.curr_FSM.

4. Save theCPU_cover.e file.

extend cpu_env {

event cpu_fsm is @sys.cpuclk;
.
.
.

};

defines FSM
sampling event

extend cpu_env {
event cpu_fsm is @sys.cpuclk;

// DUT Coverage: State Machine and State
// Machine transition coverage
cover cpu_fsm is {

item fsm: FSM_type = 'top.cpu.curr_FSM';
transition fsm;

};
};

defines the
coverage group

cpu_fsm
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Defining Coverage for the Generated
Instructions
You can use the constructs shown in Table 7-1 on page 7-2 to define coverage collection
for the CPU instruction stream:

• opcode

• op1

This coverage group uses a sampling event that is declared and triggered in the
CPU_drive.e file.

drive_one_instr(instr: instr) @sys.cpuclk is {
.
.
.

emit instr.start_drv_DUT;
.
.
.

Thus data collection for the instruction stream occurs each time an instruction is driven
into the DUT.

Procedure

To extend theinstr struct to define coverage for the generated instructions:

1. Find the portion of theCPU_cover.efile that looks like the excerpt below and review
the coverage group declaration.

extend instr {

cover start_drv_DUT is {

};

};

defines
coverage group
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2. Addopcode andop1 items to thestart_drv_DUT coverage group.

3. Save theCPU_cover.e file.

Defining Coverage for the Corner Case
Test 3 of the functional test plan (see “Test 3” on page 2-4) specifies the corner case that
you want to cover. To test the behavior of the DUT when the JMPC (jump on carry)
instruction opcode is issued, you need to be sure that the JMPC opcode is issued only when
the carry signal is high. Here, you define a coverage group so you can determine how often
that combination of conditions occurs.

Procedure

To define coverage data for the designated corner case:

1. Add acarry item to thestart_drv_DUT coverage group.

extend instr {

cover start_drv_DUT is {
item opcode;
item op1;

};
};

extend instr {

cover start_drv_DUT is {
item opcode;
item op1;
item carry: bit = 'top.carry';

};
};
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2. Define a cross item between opcode and carry.

Cross coverage lets you define the intersections of two or more coverage items,
generating a more informative report. The cross coverage item defined here shows
every combination ofcarry value andopcode that is generated in the test.

3. Save theCPU_cover.e file.

Now that you have defined the coverage groups, you are ready to simulate and view the
coverage reports.

extend instr {

cover start_drv_DUT is {
item opcode;
item op1;
item carry: bit = 'top.carry';
cross opcode, carry;

};
};
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8 Analyzing Coverage

Goals for this Chapter
The goals for this chapter are to determine whether the tests you have generated meet the
specifications in the functional test plan and use that information to decide whether
additional tests must be created to complete design verification.

What You Will Learn
In this chapter, you learn how to display coverage reports for individual coverage items,
exactly as you have defined them, and to merge reports for individual items so that you can
easily analyze the progress of your design verification.

As you work through this chapter, you gain experience with these Specman Elite features:

• Cross Coverage—This lets you view the intersections of two or more coverage items.

• Help—This helps you find the information you need in the Specman Elite Online
Documentation.

• Coverage Extensibility—This allows you to change coverage group and coverage item
definitions.
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This chapter introduces the Specview menu commands shown in Table 8-1.

The steps required to analyze test coverage for the CPU design are:

1. Running tests with coverage groups defined.

2. Viewing state machine coverage.

3. Viewing instruction stream coverage.

4. Viewing corner case coverage.

The following sections describe these tasks in detail.

Running Tests with Coverage Groups Defined
This procedure is similar to the procedure you have already used to run tests without
coverage.

Procedure

To run tests with coverage groups defined:

1. Open the working directory’s copy of theCPU_top.e file in an editor.

2. Find the lines in the file that look like this:

Table 8-1 New Specview Menu Commands Used in this Chapter

Command How the Command is Used

Tools>>Coverage Displays coverage reports and creates cross-coverage reports.

Help>>Help Browser Invokes the Specman Elite Online Documentation browser.

// Add Coverage:
//import CPU_cover;
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3. Remove the comment characters in front of theimport line so the lines look like this:

4. Click Reload to reload the files for test 2.

Tip If you have exited Specview, you must reinvoke it and loadCPU_tst2.e again.
To do so, enter thespecview command at the UNIX prompt, click on the Load
button, and chooseCPU_tst2.e.

5. Click Modules to confirm that seven modules are loaded:

CPU_instr
CPU_misc
CPU_dut
CPU_drive
CPU_cover
CPU_top
CPU_tst2

6. Click Test.

You should see something similar to the following in the Specview main window. The
last line indicates that coverage data was written to an .ecov file (a coverage data file).

test
Doing setup…
Generating the test using seed 0x1
Starting the test…
Running the test…
DUT executing instr   0 :       ADD    REG0x3, REG0x0
DUT executing instr   1 :       ANDI   REG0x3, @0x20
DUT executing instr   2 :       XOR    REG0x3, REG0x2
DUT executing instr   3 :       ADD    REG0x3, REG0x1
DUT executing instr   4 :       SUBI   REG0x3, @0x9f
.
.
.
Last specman tick - stop_run() was called
Normal stop - stop_run() is completed
Checking the test ...
Checking is complete - 0 DUT errors, 0 DUT warnings.
Wrote 1 cover_struct to CPU_tst2_1.ecov

// Add Coverage:
import CPU_cover;
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Viewing State Machine Coverage
You have two reports to look at, the state machine register report and the state machine
transition report.

If you are using a different seed or a version of the Specman Elite verification system other
than 4.0, you may see different results in your coverage reports.

Procedure

1. Click the Coverage button in the Specview main window.

The Coverage window appears.

2. In the Group frame on the left, click the+ to the left ofcpu_env.cpu_fsm and then
choosefsm.

The state machine register report appears in the right-hand frames.
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From the report it is easy to see that, for example, thefetch1state was entered 88 times
in the 227 times sampled.

3. In the Group frame on the left, choosetransition_fsm.

The state machine transition report appears in the right-hand frames.
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As you scroll down the display, perhaps the first thing you notice about the state
machine transition report is that there are a number of transitions that never occurred.
This is because these transitions are illegal.
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You can change the display to show data for transitions that have occurred only by
clicking the Full button at the top of the coverage window. (The All button shows data
for all transitions, and the Holes button shows data for transitions that have not
occurred.)

You can also define transitions as illegal so that they do not appear in the coverage
report, as described in the following steps.

4. To see how to define transitions as illegal so that they do not appear in the coverage
report, choose Help Browser from the Help menu in the Specview main window (or
you can click the large Verisity button).

The Specman Elite Online Documentation browser appears.

5. Enter the wordstransition cover item syntax in the Search field and press Return.

Thetransition construct is a coverage item, so this search will find the description of
the correct syntax for this construct.

Full button
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6. When the list of topics that describe coverage item options appears, choose the first
item in the list,eref: transition cover item syntax.

The tageref indicates that this document is part of theeLanguage Reference Manual.

7. When thetransition construct description appears, scroll down the page to theillegal
coverage item option description.

8. Continue scrolling down to the Examples section, and you will find an example
showing the use of theillegal option:

cover state_change is {
item st;
transition st using illegal =

not ((prev_st == START and st == FETCH1)
or (prev_st == FETCH1 and st == FETCH2)
or (prev_st == FETCH1 and st == EXEC)
or (prev_st == FETCH2 and st == EXEC)
or (prev_st == EXEC and st == START));

};

If you like, you can follow this example to enhance thetransition  statement in
CPU_cover.e to ignore the illegal transitions.
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Viewing Instruction Stream Coverage
We now look at the coverage for the CPU instruction stream. To provide more interesting
results for examination, we will load the results of a set of regression tests. These
regression tests were run with the second test and many different seeds.

Procedure

To view instruction stream coverage:

1. Copysrc/regression_4.0.ecov file to the working directory.

2. Click Coverage in the Specview main window.

The Coverage window appears.

3. In the File menu in the Coverage window, choose Clear Data to remove the coverage
data from the previous test.

4. In the Coverage window, click Read to open the Read Files dialog box. Select
regression_4.0.ecov, then click Read in the Read Files dialog box to read in the file.

5. In the Group frame on the left, click the+ to the left ofinstr.start_drv_DUTand then
chooseopcode.
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The opcode coverage report appears in the right-hand frames. These results show that
the current set of tests fulfill the requirement in the functional test plan to focus on
arithmetic and logic operations rather than control flow operations.

6. In the Group frame on the left, chooseop1.

Theop1 coverage report appears in the right-hand frames. All possibleop1 values
appear to be well covered.

7. On the Coverage window toolbar, click Cross.
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8. When the Define Interactive Coverage dialog box appears, click on the + next to
instr.start_drv_DUT to expand it.

9. UnderSelect Items to Add, chooseopcodeand click the Add button. Then chooseop1
and click Add again.
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10. Click OK to display a coverage report of the newcross_opcode_op1 item.

This coverage report shows whether the tests have covered every possible
combination of opcode and register.

Extending Coverage
The coverage group is extended by the addition of a new item, and by making an existing
item a per-instance item, which allows us to see coverage separately for different subtypes.

Procedure

To extend a coverage group:

1. Copy thesrc/CPU_cover_extend.e file to the working directory and open the
CPU_cover_extend.e file in an editor.
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2. Find the lines in the file that look like this:

3. Add the coverage group extension struct member. Do not forget the closing bracket.

The syntax for a coverage group extension is the same as for the original coverage
group definition, butis also instead of justis.

extend instr {

    // Extend the start_drv_DUT cover group with "is also"

// Add the kind field to the cover group as a new item

        // Extend the op1 item to make it a per_instance item
};

extend instr {

    // Extend the start_drv_DUT cover group with "is also"
cover start_drv_DUT is also {

// Add the kind field to the cover group as a new item

        // Extend the op1 item to make it a per_instance item
};

};
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4. Add a new coverage item to cover the kind field of the instr struct.

5. Extend the op1 item withusing also, to make it a per_instance item.

Since the op1 item can have one of the enumerated types REG0, REG1, REG2, or
REG3, making this item a per_instance item will provide separate coverage for each
of those four subtypes.

6. Save theCPU_cover_extend.e file.

7. Open the working directory’sCPU_top.e file in an editor.

extend instr {

    // Extend the start_drv_DUT cover group with "is also"
    cover start_drv_DUT is also {

// Add the kind field to the cover group as a new item
item kind;

        // Extend the op1 item to make it a per_instance item
    };
};

extend instr {

    // Extend the start_drv_DUT cover group with "is also"
    cover start_drv_DUT is also {

// Add the kind field to the cover group as a new item
        item kind;

        // Extend the op1 item to make it a per_instance item
item op1 using also per_instance;

    };
};
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8. Find the lines in the file that look like this:

9. Remove the comment characters in front of theimport line so the lines look like this:

10. Save theCPU_top.e file.

11. Click the Reload button to reload the files for test 2.

Tip If you have exited Specview, you must reinvoke it and loadCPU_tst2.e again.
To do so, enter thespecview command at the UNIX prompt, click on the Load
button, and chooseCPU_tst2.e.

12. Click Modules to confirm that eight modules are loaded:

CPU_instr
CPU_misc
CPU_dut
CPU_drive
CPU_cover
CPU_cover_extend
CPU_top
CPU_tst2

13. Click Test.

You should see something similar to the following in the Specview main window. The
last line indicates that coverage data was written to an .ecov file (a coverage data file).

test
Doing setup…
Generating the test using seed 0x1
Starting the test…
Running the test…
DUT executing instr   0 :       ADD    REG0x3, REG0x0
DUT executing instr   1 :       ANDI   REG0x3, @0x20
DUT executing instr   2 :       XOR    REG0x3, REG0x2

// Extend Coverage:
//import CPU_cover_extend;

// Extend Coverage:
import CPU_cover_extend;
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DUT executing instr   3 :       ADD    REG0x3, REG0x1
DUT executing instr   4 :       SUBI   REG0x3, @0x9f
.
.
.
Last specman tick - stop_run() was called
Normal stop - stop_run() is completed
Checking the test ...
Checking is complete - 0 DUT errors, 0 DUT warnings.
Wrote 1 cover_struct to CPU_tst2_1.ecov

The coverage data now includes information about the number of samples of each subtype
(REG0, REG1, REG2, REG3) of theinstr type. Each sample also includes information
about the newkind item. In the next procedure, we view this new information for a series
of tests run previously using different seeds.

Viewing Coverage Per Instance
We now look at the per-instance coverage for the op1 subtypes. As in ““Viewing
Instruction Stream Coverage” on page 8-9, we will load the results of a set of regression
tests. These regression tests were run with many different seeds. The results of each test
were merged into a file namedregression_4.0.ecov. In the following procedure, we load
theregression_4.0.ecov file into the Coverage GUI and view the merged coverage data.

Procedure

To view coverage by op1 subtype of the instr instances:

1. Click Coverage in the Specview main window.

The Coverage window appears.

2. In the File menu in the Coverage window, choose Clear Data to remove the coverage
data from the previous test.

3. In the Coverage window, click Read to open the Read Files dialog box. Select
regression_4.0.ecov, then click OK in the Read Files dialog box to read in the file.
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In the left panel, we now see that the instr.start_drv_DUT data has four additional
entries: instr.start_drv_DUT(op1==REG0) to instr.start_drv_DUT(op1==REG3).

4. In the Group frame on the left, click the+ to the left of
instr.start_drv_DUT(op1==REG0).

We see that the kind item now appears in the instr.start_drv_DUT group.

5. Choosekind.



Analyzing Coverage Viewing Coverage Per Instance

8-18 © Verisity Design, Inc. Specman Elite Tutorial

The coverage data for theimm andreg values of kind appears in the right panels.
These are the coverage results for kind when the op1 value is REG0, since we selected
the instr.start_drv_DUT(op1==REG0) instance in the left panel.

6. In the Group frame on the left, click the+ to the left ofinstr.start_drv_DUTand each
of the instances (op1==REG1), (op1==REG2), (op1==REG3) to expand the top
instance and all of the subtypes.

We see that thecross__opcode__carry item has a different grade for each instance.

7. Choose eachcross__opcode__carry item in turn to see which crosses of opcode and
carry never occurred at all (shown underinstr.start_drv_DUT), and which additional
crosses never occurred under each particular subtype.

8. In the Coverage window, click Close to close the window.

In the next chapter, we see how to modify the test files to push the test into a corner that is
not being covered well by the current test, as shown by the results above and by the
following procedure.
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Viewing Corner Case Coverage
Our corner case coverage shows how many times the JMPC opcode was issued when the
carry bit was high.

Procedure

To view corner case coverage of the JMPC opcode:

1. Click Coverage in the Specview main window.

The Coverage window appears.

2. In the Group frame on the left, click the+ to the left ofinstr.start_drv_DUTand then
choosecross__opcode__carry.

The cross-coverage report for opcode and carry appears in the right-hand frames.

3. Scroll down to the JMPC opcode.

You can see that the JMPC code was issued 12 times, and that carry was low each
time.

The ability to cross test input with the DUT’s internal state yields the valuable information
that the tests created so far do not truly test the JMPC opcode. You could raise the weight
on JMPC and hope to achieve the goal. However, many simulation cycles would be wasted
to cover this corner case. The Specman Elite system lets you attack this type of corner case
scenario much more efficiently. In the next chapter you learn how to do this.
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9 Writing a Corner Case Test

Goals for this Chapter
As described in the Functional Test Plan, you want to create one corner case test that
generates the JMPC opcode when the carry signal is high.

What You Will Learn
As you work through this chapter, you learn an effective methodology for addressing
corner case scenario testing. With Specman Elite’son-the-fly test generation, you can
direct the test to constantly monitor the state of signals in the DUT and to generate the right
test data—at the right time—to reach a corner case scenario. This feature spares you the
time-consuming effort required to write deterministic tests to reach the same result.

This chapter introduces theeconstructs shown in Table 9-1.

Table 9-1 New Constructs Used in this Chapter

Construct How the Construct is Used

'signal' * weight :
value

Used as an expression containing a DUT signal within the
select block of akeep soft constraint that controls the
distribution of generated values.
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The steps required to create the corner case test are:

• Increasing the probability of arithmetic operations.

• Linking JMPC generation to the DUT’s carry signal.

The following section describes these tasks in detail.

Increasing the Probability of Arithmetic
Operations
The goal of this test is to generate the JMPC opcode only when the carry signal is high.
The carry signal can only be high when arithmetic operations are performed. Therefore,
the test should favor generation of arithmetic operations over other types of operations.

Procedure

To increase the probability of arithmetic operations:

1. Copy thesrc/CPU_tst3.efile to the working directory and open theCPU_tst3.efile in
an editor.

2. Find the portion of the file that contains thekeep soft constraint.

extend instr {
keep soft opcode == select {

// high weights on arithmetic

// generation of JMPC controlled by the carry
// signal value

};
};
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3. Put a high weight on arithmetic operations and low weights on the others.

4. Save theCPU_tst3.e file.

Linking JMPC Generation to the Carry Signal
If you generate the list of instructions before simulation, there is only a low probability of
driving a JMPC instruction into the DUT when the carry signal is asserted. A better
approach is to monitor the carry signal and generate the JMPC instruction when the carry
signal is known to be high.

This methodology lets you reach the corner case from multiple paths, in other words, from
different opcodes issued prior to the JMPC opcode. This test shows how the DUT behaves
under various sequences of opcodes.

extend instr {
keep soft opcode == select {

// high weights on arithmetic
40 : [ADD, ADDI, SUB, SUBI];
20 : [AND, ANDI, XOR, XORI];
10 : [JMP, CALL, RET, NOP];

// generation of JMPC controlled
// by the carry signal value

};
};

keeps high weight
on arithmetic

operations
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Procedure

1. Find the portion of theCPU_tst3.e file that looks like this:

2. On a separate line within theselect block, enter a weight for the JMPC opcode, as a
function of the carry signal (weight is 0 when carry = 0, or 90 when carry = 1).

3. Save theCPU_tst3.e file.

You are now ready to run this test to create the corner case test scenario. Before running
this test, however, you want to address another important part of functional verification:
self-checking module creation. In the next chapter, you learn easy self-checking module
creation, another powerful feature provided by the Specman Elite system.

extend instr {
keep soft opcode == select {

// high weights on arithmetic
40 : [ADD, ADDI, SUB, SUBI];
20 : [AND, ANDI, XOR, XORI];
10 : [JMP, CALL, RET, NOP];

// generation of JMPC controlled by the
// carry signal value

};
};

extend instr {
keep soft opcode == select {

// high weights on arithmetic
40 : [ADD, ADDI, SUB, SUBI];
20 : [AND, ANDI, XOR, XORI];
10 : [JMP, CALL, RET, NOP];

// generation of JMPC controlled by the
// carry signal value
'top.carry' * 90 :JMPC;

};
};
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10 Creating Temporal and
Data Checks

Goals for this Chapter
In this chapter, you check timing-related dependencies and automate the detection of
unexpected DUT behavior by adding a self-checking module to the verification
environment.

What You Will Learn
In this chapter, you learn how to create temporal checks for the state machine control
signals. You also learn how to implement data checks using a reference model.

As you work through this chapter, you gain experience with two of the Specman Elite
verification system’s enabling features:

• Specman Elite temporal constructs—These powerful constructs let you easily
capture the DUT interface specifications, verify the protocols of the interfaces, and
efficiently debug them. The temporal constructs minimize the size of complex
self-checking modules and significantly reduce the time it takes to implement
self-checking.
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• Specman Elite data checking—Data checking methodology can be flexibly
implemented in the Specman Elite system. For data-mover applications like switches
or routers, you can use powerful built-in constructs for rule-based checking. For
processor-type applications like the application used in this tutorial, reference model
methodology is commonly implemented.

This chapter introduces theeconstructs shown in Table 10-1.

The steps required to implement these checks are:

1. Creating the temporal checks.

2. Creating the data checks.

3. Running the test with checks.

The following sections describe these tasks in detail.

Creating the Temporal Checks
The design specifications for the CPU require that after entering theexecute state, the
fetch1 signal must be asserted in the following cycle. This is a temporal check because it
specifies the correct behavior of DUT signals across multiple cycles.

Procedure

To create the temporal check:

1. Copy thesrc/CPU_checker.efile to the working directory and open theCPU_checker.e
file in an editor.

Table 10-1 New Constructs Used in this Chapter

Construct How the Construct is Used

expect Checks that a temporal expression is true and if not, reports an error.

check Checks that a Boolean expression is true and if not, reports an error.
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2. Find the portion of the file that looks like this:

3. Define a temporal check for theenter_exec_st event by creating anexpect statement.

4. Save theCPU_checker.e file.

// Temporal (Protocol) Checker
event enter_exec_st is

(change('top.cpu.curr_FSM')and
true('top.cpu.curr_FSM' == exec_st))
@sys.cpuclk;

event fetch1_assert is
(change('top.fetch1')and
true('top.fetch1' == 1)) @sys.cpuclk;

//Interface Spec: After entering instruction
//execution state, fetch1 signal must be
//asserted in the following cycle.

defines start of
exec state

defines rise of
fetch1

// Temporal (Protocol) Checker
event enter_exec_st is

(change('top.cpu.curr_FSM')and
true('top.cpu.curr_FSM' == exec_st))
@sys.cpuclk;

event fetch1_assert is
(change('top.fetch1')and
true('top.fetch1' == 1)) @sys.cpuclk;

//Interface Spec: After entering instruction
//execution state, fetch1 signal must be
//asserted in the following cycle.
expect @enter_exec_st => {@fetch1_assert}

@sys.cpuclk else
dut_error("PROTOCOL ERROR");

issues an error
message if fetch1

does not rise
exactly one cycle

after entering
execute state
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Creating Data Checks
To determine whether the CPU instructions are executing properly, you need to monitor
the program counter, which is updated by many of the control flow operations.

Reference models are not required for data checking. You could use a rule-based
methodology. However, reference models are part of a typical strategy for verifying CPU
designs. The Specman Elite system supports reference models written in Verilog, VHDL,
C, or, as in this tutorial,e. All you need to do is to create checks that compare the program
counter in the DUT to their counterparts in the reference model.

Procedure

Creating data checks has two parts:

• Adding the data checks

• Synchronizing the reference model execution with the DUT

Adding the Data Checks

To add the data checks:

1. Find the portion of theCPU_checker.e file where theexec_done event is defined.

Notice that there is an event,exec_done, and associated method,on_exec_done. The
Specman Elite system automatically creates an associated method for every event you
define. The method is empty until you extend it. The method executes every time the
event occurs.

// Data Checker
event exec_done is (fall('top.exec') and

true('top.rst' == 0))@sys.cpuclk;

on_exec_done() is {
// Compare PC - program counter

};
.
.
.

event definition

method
associated with

event
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2. Add a check for the program counter by creating acheck statement.

3. Save theCPU_checker.e file.

Synchronizing the Reference Model with the DUT

To synchronize the reference model with the DUT:

1. Open theCPU_drive.e file in the working directory.

2. At the top of the file find the line that imports the CPU reference model and remove
the comment characters from theimport line.

// Data Checker
event exec_done is (fall('top.exec') and

true('top.rst' == 0))@sys.cpuclk;

on_exec_done() is {
// Compare PC - program counter
check that sys.cpu_dut.pc ==

sys.cpu_refmodel.pc else
dut_error("DATA MISMATCH(pc)");

};

issues an error if
there is a

mismatch in the
program counters

of the DUT and
the reference

model

<'
import CPU_refmodel;

extend sys {
event cpuclk is

(fall('top.clk')@tick_end);

cpu_env : cpu_env;
cpu_dut : cpu_dut;

 //cpu_refmodel : cpu_refmodel;
};
'>

imports the
reference model
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3. Find the line that extends the Specman Elite system by creating an instance of the CPU
reference model and remove the comment characters.

4. Find the line in thereset_cpu TCM that resets the reference model and remove the
comment characters.

5. Find the line in thedrive_one_instrTCM that executes the reference model when the
DUT is in the execute state and remove the comment characters.

6. Save theCPU_drive.e file.

<'
import CPU_refmodel;

extend sys {
event cpuclk is

(fall('top.clk')@tick_end);

cpu_env : cpu_env;
cpu_dut : cpu_dut;
cpu_refmodel : cpu_refmodel;

};
'>

creates an
instance of the

reference model

reset_cpu() @sys.cpuclk is {
'top.rst' = 0;
wait [1] * cycle;
'top.rst' = 1;
wait [5] * cycle;
sys.cpu_refmodel.reset();
'top.rst' = 0;

};

resets the
reference model

// execute instr in refmodel
sys.cpu_refmodel.execute(instr,sys.cpu_dut);

};
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Running the Simulation
This procedure, which involves loading the appropriate files and then executing the test, is
very similar to the procedure you used in previous chapters to generate other tests.

The only difference is that this time you include the reference model and checks.

Procedure

To run the simulation:

1. Open the working directory’s copy of theCPU_top.e file in an editor.

2. Find the lines in the file that look like this:

3. Remove the comment characters in front of theimport line so the lines look like this:

4. Save theCPU_top.e file.

5. Copy thesrc/CPU_refmodel.e file to the working directory.

6. Invoke Specview, if it is not already running:

% specview &

7. Click Restore to remove any loaded modules from the current session.

8. Click Load and loadCPU_tst3.e.

Remember that this is the test that you wrote in Chapter 9, “Writing a Corner Case
Test”.

9. Click Test to run the simulation.

// Add Checking:
//import CPU_checker;

// Add Checking:
import CPU_checker;
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It looks like we hit a bug here. The Specman Elite system is reporting a protocol
violation.

test
Doing setup ...
Generating the test using seed 7...
Starting the test ...
Running the test ...
DUT executing instr   0 : XOR REG0x0, REG0x2
DUT executing instr   1 : ADD REG0x2, REG0x3
DUT executing instr   2 : CALL REG0x1, @0x09
DUT executing instr   3 : ANDI REG0x1, @0x65
DUT executing instr   4 : AND REG0x1, REG0x0
DUT executing instr   5 : ADD REG0x0, REG0x2
DUT executing instr   6 : SUB REG0x0, REG0x1
DUT executing instr   7 : XORI REG0x3, @0xca
DUT executing instr   8 : ADDI REG0x3, @0xcb
DUT executing instr   9 : ADDI REG0x1, @0xc0
DUT executing instr  10 : ANDI REG0x1, @0xd6
DUT executing instr  11 : SUB REG0x0, REG0x2
.
.
.
*** Dut error at time 2246

Checked at line 42 in @CPU_checker
In cpu_env-@0:

PROTOCOL ERROR

Will stop execution immediately (check effect is ERROR)

*** Error: A Dut error has occurred

*** Error: Error during tick command

Tip If you are using a version of Specman Elite that is not 4.0, it is possible that the
DUT error will not occur on the first test or that it will occur at a different time.
If it does not occur, reload the test and specify a seed other than the default (1).
When the error occurs, note the exact time when it occurred. You will use this
information in the next chapter to debug the error.
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10. Click the error hyperlink to view the line in the source that generated this message.

This message comes from the checker module that you just created.

In the next chapter, you learn how to identify the conditions under which this bug occurs
and how to bypass the bug until it can be fixed.
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11 Analyzing and Bypassing
Bugs

Goals for this Chapter
The main goal for this chapter is to debug the temporal error generated during your
previous tutorial session (Chapter 10, “Creating Temporal and Data Checks”). At the end
of this chapter, you also learn how to direct the generator to bypass a test scenario that
causes an error.

What You Will Learn
As you work through this chapter, you gain experience with two of the Specman Elite
system’s enabling features:

• The Specman Elite debugger—Provides powerful debugging capability with
visibility into the HDL design.

• The Specman Elite bypass feature—Lets you temporarily prevent the Specman Elite
system from generating test data that reveals a bug in the design. With this feature you
can continue testing while the bug is being fixed.
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This chapter introduces the Specview menu commands shown in Table 11-1.

The steps for debugging the temporal error are:

1. Displaying DUT values.

2. Setting breakpoints.

3. Stepping the simulation.

4. Bypassing bugs.

The following sections describe how to perform these tasks.

Displaying DUT Values
If you have just completed Chapter 10, “Creating Temporal and Data Checks”, the
PROTOCOL ERROR message is still displayed on the Main Specman window. If you
exited Specview, you will have to reinvoke Specview and run the simulation again, as
described in “Running the Simulation” on page 10-7. Then continue with the procedure
below.

Table 11-1 New Specview Menu Commands Used in this Chapter

Command How the Command is Used

Debug>>Thread Browser Opens the Thread Browser, which displays all the
TCMs (threads) that are currently active.

Debug>>Open Debug
Window

Opens the Debugger window, which displays the
source for the current thread with the current line
highlighted.

Debugger: View>>Print Displays the current value of an evariable.

Debugger: Breakpoint>>
Set Breakpoint>>Break

Sets a breakpoint on the currently highlighted line of
ecode.

Debugger: Run>>Step Any Advances simulation to the next line ofecode
executed in any thread.

Debugger: Run>>Step Advances simulation to the next line ofecode
executed in the current thread.
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Procedure

To display DUT values:

1. In the Specview main window, click the Threads button or choose Thread Browser
from the Debug menu.

The Thread Browser appears.

The Thread Browser indicates the status of each TCM that is currently active in the
Specman Elite system:

• Clock generation

• Drive and Sample CPU

• DUT

To debug the error, look first at the TCM that drives the DUT.

2. On the line forcpu_env-@0.drive_cpu, click onSrc to bring up the corresponding
source file for this thread.

The Debugger window appears, showingCPU_drive.e.
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3. Click the Line # button in the Debugger window to display line numbers.

The highlighted line (line 56) shows that thedrive_one_instr TCM is waiting for the
top.exec signal to rise.

4. To find out the current instruction type, highlight the phraseinstr.kind, located 9 lines
above (line 47) the highlightedwait statement and click Print.

For
step 3

For
step 5
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The Data Browser opens and shows that theinstr.kind is an immediate instruction.

5. In a similar fashion, highlight the phraseinstr.opcodein the line four lines above (line
51) thewait statement and click Print.

In the Data Browser, you can see that the value of opcode is JMPC.

6. Optionally you can find out the value of any HDL signals. For example, to display the
value oftop.data, highlight the phrase ‘top.data’ and click Print.

Setting Breakpoints
You have determined that the bug appears on an immediate instruction when the opcode is
JMPC. It may be possible to narrow down even further the conditions under which the bug
occurs. You can set a breakpoint on the statement that drives the immediate instruction
data into the DUT to see what the operands of the instruction are.
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Procedure

To set a breakpoint:

1. Highlight any portion of the line:

'top.data' = pack(packing.high, instr.as_a(imm instr).op2);

2. On the Breakpoint menu, choose Set Breakpoint and then choose Break.

The line should now be red and underlined to indicate a breakpoint has been set.

3. On the Breakpoint menu, choose Show All Breakpoints to activate the breakpoint just
before the error occurs (at system time 2246).

The Breakpoints window appears.

4. In the edit box at the top of the window, modify the current breakpoint by adding the
condition “if (sys.time > 2200)”, as follows:

break on line 53 in @CPU_drive if (sys.time > 2200)

Tip If the error occurred at a simulation time other than 2246, choose a different
value for the sys.time expression that is at least 46 time units before the error
occurred.

5. Click Change to save the changes.

Stepping the Simulation
You can trace the exact execution order of theecode by stepping the simulation.

Edit
Box
for
step 4
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Procedure

To step the simulation:

1. Click Reload in the Specview main window to run the simulation in debug mode.

The Debugger window closes when you reload the design.

2. Click Test.

The simulation stops at the breakpoint.

3. From the Run menu in the Debugger window, choose Step Any (or click the Step Any
button) to advance to the next source line in any subsequent thread.

4. Continue clicking Step Any until the current thread is Thread #3 in the CPU_DUT.e
file, as indicated in the title bar at the top of the window.

Note If the current thread switches to Thread #0 (the Specman tick thread), the
source file is not visible. You should continue clicking Step Any.



Analyzing and Bypassing Bugs Bypassing the Bug

11-8 © Verisity Design, Inc. Specman Elite Tutorial

5. In the Debugger window, click the Step button to step through the simulation within
the current thread, Thread #3.

6. Continue clicking Step for about 35 to 40 steps until you hit the PROTOCOL error.

The Step button is greyed out, and the PROTOCOL error is displayed in the Specview
main window.

For the purpose of simplifying this tutorial, we planted an obvious bug in the DUT.
Whenever a JMPC instruction jumps to a location greater than 10, execution requires
two extra cycles to complete.

Bypassing the Bug
A common problem in traditional test generation methodology is that when there is a bug
in the design, verification cannot continue until the bug is fixed. There is no way to prevent
the generator from creating tests that hit the bug.

The Specman Elite system’s extensibility feature, however, lets you temporarily prevent
generation of the conditions that cause the bug to be revealed.

This particular bug seems to surface when the JMPC operation is performed using a
memory location greater than 10. To continue testing other scenarios, you simply extend
the test constraints to prevent the Specman Elite system from generating this combination.

Procedure

To bypass the JMPC bug:

1. Copy thesrc/CPU_bypass.e file to the working directory.

2. Open theCPU_bypass.e file in the editor.

3. Review thekeep constraint.

<'
extend imm instr {

keep (opcode == JMPC) => op2 < 10 ;

};
'>
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4. In the Specview main window, choose Debug>>All Breakpoints>>Delete All
Breakpoints.

5. Click Reload.

6. Click Load and load theCPU_bypass.e file.

7. Click Test.

This time the test runs to completion.

Tutorial Summary
Congratulations! You have successfully completed the major steps required to verify a
device with the Specman Elite verification system.

In this tutorial:

• You captured the interface specifications for the CPU instructions ineand created the
instruction stream.

• You used specification constraints to ensure that only legal instructions were generated.
You used test constraints to create a simple go-no-go test.

• You created a Specman Elite TCM (time consuming method) to define the driver
protocol and then drove the generated CPU instruction stream into the DUT. The results
confirmed that you had generated the first test and driven it correctly into the design.

• Using Specman Elite’s powerful constraint-driven generator, you generated 15 sets of
instructions. Using weight to control the generation value distribution, you effectively
focused these sets of instructions on the commonly executed portion of the CPU DUT.

• Using Specman Elite’s unique Functional Coverage Analyzer, you accurately measured
the effectiveness of the coverage of the regression tests. You identified a corner case
“hole” by viewing the graphical coverage reports.

• To address the corner case scenario, you used Specman Elite’s powerful on-the-fly
generation capability to generate a test based on the internal state of the design during
simulation. Compared to the traditional deterministic test approach, this approach tests
the corner case much more effectively from multiple paths.

• You then used the unique temporal constructs provided by the Specman Elite system
to create a self-checking monitor for verifying protocol conformance.

• When the self-checking monitor revealed a bug, the Specview debugger provided
extensive features to debug the design efficiently.
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Note that you have created this verification environment, including self-checking modules
and functional coverage analysis, in a short period of time. Once the environment is
established, creating a large number of effective tests is merely one click away. The
ultimate advantage of using the Specman Elite system is a tremendous reduction in
verification time and resources.
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A Setting up the Tutorial
Environment

To set up the tutorial environment, you need a Specman Elite license. You can get one by
sending an email toinfo@verisity.com or by calling Verisity customer support at
(650) 934-6890.

There are three procedures involved in setting up the tutorial environment:

• Downloading the Specman Elite software and tutorial files

• Installing the Specman Elite software

• Installing the tutorial files

These procedures are described in this appendix.

Note that even if Specman Elite software has already been installed in your environment,
you still have to download and install the tutorial files.

Downloading the Required Files
To download the Specman Elite software and the tutorial files from the Verisityftp site:

1. Change directory to the directory where you want to store the downloaded files.

2. Log in to the Verisityftp site in the United States or Israel.

United States:
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% ftp ftp.verisity.com
Connected to ftp.verisity.com…
Name (ftp.verisity.com: your_name ): anonymous
331 Guest login ok, send ident as password
Password: your-complete-email-address
230 Guest login ok, access restrictions apply.

Israel:

% ftp ftp-il.verisity.com
Connected to ftp.verisity.com…
Name (ftp.verisity.com: your_name ): anonymous
331 Guest login ok, send ident as password
Password: your-complete-email-address
230 Guest login ok, access restrictions apply.

3. Change directory to the private/tutors directory.

ftp> cd private/tutors
250 CWD command successful

Note The private/tutors directory contains a README file that describes the
contents of the directory.

4. Change the format type tobinary.

ftp> bin
200 Type set to I.

5. Get the Specman Elite software.

ftp> get install_specman release_number .sh
200 PORT command successful.
150 Opening BINARY mode data connection for
install_specman release_number .sh
226 Transfer complete…
ftp> get sn_rel release_number .main.tar.gz
200 PORT command successful.
150 Opening BINARY mode data connection for
sn_rel release_number .main.tar.gz…
226 Transfer complete…
ftp> get sn_rel release_number . OS.tar.gz
150 Opening BINARY mode data connection for
sn_rel release_number . OS.tar.gz…
226 Transfer complete…
ftp> get sn_rel release_number .docs.tar.gz
150 Opening BINARY mode data connection for
sn_rel release_number .docs.tar.gz…
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226 Transfer complete…

whereOS is one of the platforms that Specman Elite supports, eithersolaris or hpux.

6. Get the tutorial files. For Specman Elite version 3.3.x, use 3.3 forrelease_number. For
Specman Elite version 4.x, use 4.0 forrelease_number.

ftp> get se_tutor release_number .tar.gz
200 PORT command successful.
150 Opening BINARY mode data connection for se_tutor.tar.gz…
226 Transfer complete…
ftp>

7. Log out of ftp.

ftp> quit
221 Goodbye.

Installing the Specman Elite Software
To set the environment variables, install the files, and start up the license manager:

1. Log in to the machine where you want to install the Specman Elite software.

% rlogin solaris-machine |  hpux-machine

2. Run the installation script.

% sh ./install_specman release_number .sh

3. When the Specman Elite Install Script Menu appears, choose option 1, “Complete
installation”.

After you have installed the machine-independent files and the machine-dependent
files, the script will ask you to choose a license installation step.

4. Choose option 1, “Install license server” from the “License handling” menu.

The script creates a new license file based on the license file you obtained via e-mail,
activates the license server, updates the SPECMAN_LICENSE_FILE environment
variable, and optionally creates the “rc.specman” file.

5. After the license handling procedure is completed, install the online docs.

After you have installed the online docs, exit the installation script.

6. Source the Specman Elite environment file (env.csh or env.sh), for example:

% source install_dir/release_number/ env.csh
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7. Make sure the Specman Elite object in your PATH is the one you have just installed.

% which specman
install_dir / OS/specman
%

8. To check the installation, start the Specman Elite graphical interface.

% specview &

Tip If you have difficulty starting Specview or obtaining a license, call Verisity
customer support at (650) 934-6890.

Installing the Tutorial Files
To install the tutorial files.

1. Change directory to the directory where you want to install the tutorial files.

% cd tutor_dir
%

2. Unzip and untar the se_tutor.tar.gz file.

% gunzip se_tutor release_number .tar.gz
% tar -xvf se_tutor.tar

3. List the directory contents to see the file structure.

% ls *

gold:
CPU_bypass.e CPU_dut.e CPU_tst1.e
CPU_checker.e CPU_instr.e CPU_tst2.e
CPU_cover.e CPU_misc.e CPU_tst3.e
CPU_cover_extend.e CPU_refmodel.e regression_4.0.ecov
CPU_drive.e CPU_top.e

src:
CPU_bypass.e CPU_dut.e CPU_tst1.e
CPU_checker.e CPU_instr.e CPU_tst2.e
CPU_cover.e CPU_misc.e CPU_tst3.e
CPU_cover_extend.e CPU_refmodel.e regression_4.0.ecov
CPU_drive.e CPU_top.e
%
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You can see that there are two sets of files. As you work through this tutorial, you will
be modifying the files in thesrc directory. If you have trouble making the
modifications correctly, you can view or use the files in thegolddirectory. The files in
thegold directory are complete and correct.

Now that the files are installed, you are ready to proceed with the design verification task
flow shown in Figure 1-2 on page 1-3. To start the first step in that flow, turn to Chapter 2,
“Understanding the Environment”. In this chapter, you review the DUT specifications and
functional test plan for the CPU design and define the overall verification environment.
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B Design Specifications for
the CPU

This document contains the following specifications:

• CPU instructions

• CPU interface

• CPU register list

CPU Instructions
The instructions are from three main categories:

• Arithmetic instructions— ADD, ADDI, SUB, SUBI

• Logic instructions—AND, ANDI, XOR, XORI

• Control flow instructions—JMP, JMPC, CALL, RET

• No-operation instructions—NOP

All instructions have a 4-bit opcode and two operands. The first operand is one of four
4-bit registers internal to the CPU. This same register stores the result of the operation, in
the case of arithmetic and logic instructions.
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Based on the second operand, there are two categories of instructions:

• Register instructions—The second operand is another one of the four internal
registers.

• Immediate instructions—The second operand is an 8-bit value contained in the next
instruction. When the opcode is of type JMP, JMPC, or CALL, this operand must be a
4-bit memory location.

Figure B-1 Register Instruction

Figure B-2 Immediate Instruction

Table B-1 shows a summary description of the CPU instructions.

byte 1

bit 7 6 5 4 3 2 1 0

opcode op1 op2

byte 1 2

bit 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

opcode op1 don’t
care

op2

Table B-1 Summary of Instructions

Name Opcode Operands Comments

ADD 0000 register, register ADD; PC <- PC + 1

ADDI 0001 register, immediate ADD immediate; PC <- PC + 2

SUB 0010 register, register SUB; PC <- PC + 1

SUBI 0011 register, immediate SUB immediate; PC <- PC + 2

AND 0100 register, register AND; PC <- PC + 1

ANDI 0101 register, immediate AND immediate; PC <- PC + 2

XOR 0110 register, register XOR; PC <- PC + 1
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CPU Interface
The CPU has three inputs and no outputs, as shown in Table B-2.

When the CPU is reset by therst signal,rst must return to its inactive value no sooner than
min_reset_duration and no later thanmax_reset_duration.

XORI 0111 register, immediate XOR immediate; PC <- PC + 2

JMP 1000 immediate JUMP; PC <- immediate value

JMPC 1001 immediate JUMP on carry;
if carry = 1 PC <- immediate value
else PC <- PC + 2

CALL 1010 immediate Call subroutine;
PC <- immediate value;
PCS <- PC + 2

RET 1011 Return from call; PC <- PCS

NOP 1100 Undefined command

Table B-2 Interface List

Function Direction Width Signal Name

CPU instruction input 8 bits data

clock input 1 bit clock

reset input 1 bit rst

Table B-1 Summary of Instructions (continued)

Name Opcode Operands Comments
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CPU Register List
The CPU has six 8-bit registers and one 4-bit register, as shown in Table B-3.

Table B-3 Register List

Function Width Register Name

state machine
register

4 bits curr_FSM

program counter 8 bits pc

program counter
stack

8 bits pcs

register 0 8 bits r0

register 1 8 bits r1

register 2 8 bits r2

register 3 8 bits r3
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